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13.00-01   [80441] 2013-07-05

  New Features and Changes

Data Model:

Time profile item relation -> Vehicle journey item: Evaluation of the time profile item relation by vehicle
journey item has been sped up. (12541)

Foreign Formats:

VDV452 import: For VDV452 import, 12-digit version numbers are now permitted in order to
accommodate the particulars of supplying systems, even if the format provides for a 9-digit number.
(12641)

Graphical procedures:

Adding flow bundle terms: The process for adding new terms to a flow bundle has been simplified and
is now more logic. When adding new terms, no more dialogs are displayed, but default settings are
used for traffic types, similar to as for some network object types. When you add zones, for the first
zone of a group, the default traffic type is 'Origin demand'. For the second zone, it is 'Destination
demand'. Adding additional zones is still not permitted. The COM methods for adding flow bundle terms
have not been changed. (12588)

Graphics:

Background maps: The background maps have been rounded off with several smaller improvements.
In particular, the map is now also drawn, if there are invalid sections in the visible section. (12517)

Dynamic legend entries: The new legend now responds to changes of dynamic entries (particularly of
the POI categories) by updating the names of the legend items. (12603)

Installation:

Codemeter 4.50b: This service pack (and all future ones) require Codemeter version 4.50b or higher.
Local dongle drivers are updated automatically during the update process. If network dongles are used
on remote computers, the Codemeter runtime software has to be updated on the licence server as well.
(12681)

Network Editor:

Inserting a stop point: When you insert a stop point, a stop and a stop area are also inserted. Then a
type number is entered for the stop point (analogous to code and name), which is also adopted for the
stop area and the stop. (12598)

PrT Assignment:

ICA, two-way stop: The impact of flared approaches is now accounted for in the calculation. (12206)

Two-way nodes: Within ICA calculation, for node impedance calculation according to HCM 2000 or
HCM 2010, the 'two-stage gap acceptance' method is provided for two-way nodes. (12278)

PuT Operating Indicators:

Speed-up for 'only active': The procedure 'PuT operating indicators' has been sped up further for cases
in which there are many vehicle journey sections, but only few active ones, and you want to use the
active vehicle journey sections only. (12647)

Scenario Mangement:

Tables in the 'Edit Project' dialog: Tables can now be sorted by any column. You can also use the copy
and paste commands for the 'Procedure parameter set' column in the 'Scenarios' dialog. (11329)

TFlowFuzzy:



Display of network objects affected: In the Message window, you can now highlight network objects for
which messages are generated during 'Demand matrix correction (TFlowFuzzy)' or the analysis.
(12284)

VISUM Files, Scenario Management:

Matrices within model transfer files: Creation of model transfer files has been sped up in the case that
identical matrices exist in both networks. This is particularly useful when editing modifications in the
context of scenario management. (12112)

  Fixed Bugs

Add-Ins:

Buffers around PuT lines: The program no longer crashes when you carry out the add-in 'Buffers
around PuT lines' and the name of one of the lines or line routes contains a special character. (12620)

Coordinates in VDV452 import: During VDV452 import, coordinates are now converted correctly from
degrees into decimals, as commonly used in PTV Visum. (12639)

Import Transit Supply: When you import supply data via the 'Import Transit Supply' add-in, now also
allocations between transport systems are suggested, whose codes only differ in upper and lower case
letters. (12522)

Nested Demand Model: The add-in 'Nested Demand Model' can now also be used with Visum 13.
(12567)

COM Interface:

SetMultiAttValues and variants: The method SetMultiAttValues and its variants SetMulti of the VisumPy
library did not work for the network objects matrix toll, OD pairs, and main zone paris. This error has
been fixed. (12606)

Data Model, Other procedures:

Different territory indicators: For the attributes Passengers boarding, Passengers alighting, Passengers
transferring, Vehicle hours traveled, Vehicle kilometers traveled, and Mean volume per Trip (each per
territory), the indication of source has been corrected. In addition, now the number of passengers
boarding, alighting and transferring within the territory are also calculated via the procedure 'PuT
operating indicators', if you select the option 'Also calculate indicators of the 'Territory indicators'
procedure'. (11818)

Data Model:

Attribute destination demand at main zone: Evaluation of the attribute 'destination demand-DSeg at
main zone' has been signficantly sped up. (12491)

Editing vertices: When you deleted vertices of a toll system that were also used by the polygon of a
main node, Visum could freeze. This error has been fixed. (12686)

Formula attributes: In formula attributes with the operator Round(x,p), operator x was not evaluated, but
p was rounded to p places. This error has been fixed. Formula matrices are not affected thereof.
(12688)

Demand procedures:

Formula matrices in utility definitions: So far you could enter formula matrices in the utitility definitions of
various demand procedures, but they were deleted when you read in procedure parameters from files
(Version file, procedure parameters binary and XML). This is no longer the case, i.e. formula matrices
can now be used in utility definitions without any limitations. Demand matrices are no longer deleted
from utility definitions, but they are not offered for insertion either. Should you wish to use them, change
the formula accordingly. (12397)

Dialogs:

Attribute selection: Setting of the C/A/H sorting switch is no longer lost during the session. (12608)

Editing a non-numeric classification: If in the Graphic Parameters dialog for bars of a network object
type, on the dialog side for network object selection (e.g. 'Link selection'), the option 'Bars only on
selected links' was activated and a non-numeric attribute selected, Visum crashed when you clicked
'Edit'. This error has been fixed. (12679)

Ending a search: If you clicked the 'Stop search' button to cancel a search that had already been
ended, the search results were deleted. This error has been fixed. (12611)



Graphic parameters, bar labeling: If for bar labeling, you select 'Sum only', the setting 'Color like bar'
does not make any sense and is thus no longer offered in the dialog. (12503)

Network statistics: In the network statistics, line data and main line data were mixed up. This error has
been fixed. (12637)

Parameters for volume-delay function: The program no longer crashes when in the dialog
'Volume-delay function parameters', 0 is entered as the volume-delay function number. (12597)

Position outside the screen: When dialogs are opened, it is now checked whether their position saved
during the last session lay outside the screen. If this is the case, the position saved is discarded and the
dialog is opened and displayed at its initial position. (12220)

Search dialog: After you restored the search dialog from a version file, the results list was initially empty
until the search was started again. This error has been fixed. (12610)

Search dialog: The column widths of the table are saved per network object type and are restored when
reopened. (12609)

Filters:

Line filters and couplings: The line filter was not always fully updated when you created or deleted
couplings. This error has been fixed. (12539)

Foreign formats:

VDV452 import: Relations between data records in VDV452 data, partly specified with leading zeros,
could not be resolved when read in. This was particularly true for line numbers wih leading zeros. This
error has been fixed. (12683)

Internet maps: You can now read in Internet maps, even if the project directory has been changed.
(11065)

Graphical procedures:

Canceling flow bundle calculation: It is now possible to cancel flow bundle calculation again. (12636)

Flow bundle and toll systems: When you calculated the flow bundle volume for toll systems, the
corresponding value was not initialized, i.e. the result was always added to the existing value. This error
has been fixed. (12621)

Supply selection with flow bundle terms: For some flow bundle terms, the 'Supply' tab did not respond
to changes made in the 'Passenger types' tab. Now - depending on the passenger types selected - the
left or the right half of the 'Supply' tab becomes inactive again. (12602)

Graphics:

Autotexts when printing lists: In Version files of previous Visum versions, autotexts in print frames of
lists were not always recognized as such. As a result, text was displayed (e.g. 'Page [page number] /
[number of pages]' instead of 'Page 17 / 35'). This error has been fixed. (12605)

Background maps: No more crash due to lack of memory if the 'intensity' value within the graphic
parameters of background maps is set to a value different from 100%. (12724)

Background maps: Online background maps used as usual background appear to be completely black
since service pack Visum 12.52-14. This problem occurs in 32bit program version only and has been
fixed now. (12729)

Bar labeling in the 'Sum only' mode: When you used 'Sum only' as the bar label, the option 'Do not
show if value <= X' did not work properly. Now a value is no longer displayed, if the sums of the
individual bars lie under their respective threshold (there is no common sum threshold). (12502)

Double spaced footer in print frame: In print frames with a double spaced footer, the footer was not
displayed correctly. This error has been fixed. (12684)

Drawing bars using rounded values: The value set for a bar in the 'Round to' attribute was always
interpreted metrically and the lengths were specified in [m]. Now the "Long length" attributes are
rounded to [km]. Imperial units are rounded accordingly to multiples of the applicable unit of measure.
(12324)

Legend with images: The program no longer crashes when opening a version file with a legend that
contains autotexts with references to images and the image files cannot be loaded. (12554)

Printing after changing projection: When you transformed a network into another coordinate system and
afterwards printed the entire network, the section was wrong. This error has been fixed. (12616)



Junction Editor:

Allocating SC of the type VISSIG: The program no longer crashes when in the Junction Editor, you
create a SC of the type VISSIG, for which a node has already been supplied or for which there is no
node. (12638)

Signal program of VISSIG controllers: In the Junction Editor and in the 'Edit SC' dialog, the option 'no
signal program' is no longer available for the signal program of VISSIG signal controls (SC), as it no
longer represents a valid status. You can model switching of the SC via the 'Switched off' attribute.
(12584)

Main Window:

Opening graphic parameters via Ctrl + G: In windows that have their own graphic parameters, the short
key combination Ctrl + G will now open their graphic parameters dialog. If no window, or one of the tool
windows is active ('Network objects', 'Matrices', 'Find',...), Ctrl + G will open the graphic parameters
dialog of the active window. (11658)

Matrix Editor:

Binary arithmetic operations with an external matrix: For binary arithmetic operations (adding,
multiplying, etc.), you can now, via file selection, choose an external matrix again as a second operand.
(12607)

Network comparisons:

Model transfer file view: If in the model transfer file view, you collapse a node in the tree, the latter is no
longer selected. In particular when you activate synchronization, the network objects (after collapsing
their tree view) are then no longer highlighted in the Network Editor. (12500)

Network Editor:

Delete enclaves: The special multi-edit command 'Delete enclaves' did not work for area objects. This
error has been fixed. (12596)

Display when editing shape of line route: If you edited the shape of a line route and then clicked Undo,
the previous route was highlighted in yellow again, but so was the route edited before the Undo
operation. This error has been fixed. (12626)

Network check - suitability for ICA: The check for ICA suitability via the 'Network check' function is now
only performed for nodes with the ICA calculation method. (12555)

Shortening line route via multiple traversed stop points: When you shortened a line route of the course
A-B-C-B-C-D with a fixed second traverse of C, so that the second traverse of C became the new
starting point, the detour to B remained part of the course (C-B-C-D instead of C-D), if the first
occurence of stop point C was a route point and the second was not. This error has been fixed. (12079)

Other procedures:

'Initialize all filter settings' procedure: During the 'Initialize all filters' procedure, the POI filter was not
initialized. This error has been fixed. (12546)

'Territory indicators' procedure: When you now calculate the vehicle hours for territories, run times on
main turns are also taken into account. (12586)

Emission calculation according to HBEFA manual: When you performed an HBEFA emission
calculation multiple times during a VISUM session, after 254 times, the files could no longer be opened
and the calculation could not be performed. This error has been fixed. (12648)

PrT Assignment:

Two-way stop, queue lengths: Queue lengths were wrongly output at rank 1 turns, if the leg had no
rank 2 turn. If the rank 2 turn shared a lane with a rank 1 turn, and there were also other lanes, the
queue length output at the rank 1 turn was far too long. (12630)

PuT Assignment:

Headway in headway-based assignment longer than 2 hours: If in headway-based assignment, you
only accounted for active time profiles, a filter was set, and the headways were adopted from a time
profile attribute, the following message: 'There is an average headway of more than 2 hours.' was not
always displayed. This error has been fixed. (12680)

PuT Line Blocking:



Open blocks: If during line blocking open blocks were generated and the link run time t-PuTSys for the
transport system used was always 0, Visum could enter an infinite loop. This error has been fixed.
(12593)

Scenario Management:

Long paths: The program no longer crashes after performing a scenario calculation when the path to
the basic project folder is too long. (12601)

Scenbario Management:

Remove computation node: No more crash when removing a computation node, if its status is being
updated at the same time. (12642)

Timetable Editor:

Scrollbar in tabular timetable: The scrollbar in the bottom left quadrant of the tabular Timetable Editor
now allows you to scroll, if the total column widths exceed the quadrant's width. (11190)

Timetable Editor opened for line selection: When the Timetable Editor was opened for an extensive
selection of lines, a warning was displayed that the calculation of the stop sequence might take quite
some time. Now the Timetable Editor is no longer opened. You can change the number of selected
lines / line routes in the Network Editor. (11290)

VISUM Files:

Canceling read network: The program no longer crashes after you cancel non-additive reading of a
network file, a demand file or a model transfer file. (12595)

Reading version file: Reading a version file failed, when you mistakenly assigned a PrT mode more
than one transport system and the file contained assignment results. This error has been fixed. (12656)

Write version / RBC: In certain cases, networks containing RBC controllers could not be saved and
Visum crashed. This error has been fixed. (12559)

  Breaking Changes

Installation:

Codemeter 4.50b: This service pack (and all future ones) require Codemeter version 4.50b or higher.
Local dongle drivers are updated automatically during the update process. If network dongles are used
on remote computers, the Codemeter runtime software has to be updated on the licence server as well.
(12681)

Other procedures:

'Territory indicators' procedure: When you now calculate the vehicle hours for territories, run times on
main turns are also taken into account. For networks that include main turns, this changes the results
accordingly. (12586)

 

13.00-00   [80106] 2013-06-21

  New Features and Changes

Add-Ins:

A new Add-in for the creation of reports for highway validation has been added. The Add-In can be
inserted into the procedure flow and generates an Excel-sheet with comparisons of surveyed and
calculated values. You can define thresholds and results can be displayed with different charts. (11365)

A new Add-in for the creation of reports for public transport validation has been added. The Add-In can
be inserted into the procedure flow and generates an Excel-sheet with comparisons of surveyed and
calculated values. You can define thresholds and results can be displayed with different charts. (12169)

General: The Python library numpy which is deployed with Visum was updated and exchanged with a
version optimized for the Intel Math Kernel Library MKL. This should result in faster operation of
Add-Ins making use of numpy (e.g. CalculateMatrix), but can eventually also lead to deviating results.
(11379)

In addition to the assignment report for highway there is now an Add-in for the generation of
assignment reports for public transport.The Add-in can be implemented into the procedure and
produces an Excel file and/or a PDF document that contains a summary of assignment results. (10800)



Message handling: The Add-Ins included in the standard installation have been adpated to the new
COM-methods (11175). Thus procedure runs will be stopped, if an error occurs. (12427)

COM Interface:

Mapmatcher: It is now possible to define the relevant attributes of links and turns for the shortest path
search within the mapmatcher. So far, only the shortest path (lengths of links) was available. (12148)

Scripts and Add-Ins can now send (optionally) errors to the procedure run using new COM-methods
(IVisum: PostOperationResultMessage, PostFailure, PostUserCancelled, Log, Ask). Thereby it can be
avoided that the full procedure run is exectued unintendly. (11175)

Standard values of links: There is now a COM method 'SetDefaultsFromLinkType', which applies
standard values to links. With this, it is among other things possible to set standard values within a
procedure flow by incorporating a brief COM-script into the procedure flow. (11137)

Data model:

Attributes for Line block items: Reading in of attribute files for block items is possible now. (7864)

Relation Nodes on Vehicle journey: For object Vehicle journey there is a relation to object Nodes. This
can be used e.g. to set a filter for traversed nodes. (10704)

Control of channelized right turns: The data model has been extended by the value "without" for the leg
attribut channelized control. (12419)

Formulas: The possibilities to define formulas have been extended. Now it is possible to apply binary
and unary operators as well as transformations and to insert parentheses to the formula. This new
definiton of formulas is available for the definition of matrices and attributes with formulas and in the
procedures 'Combination of matrices and vectors' and 'Edit attribute'.
In the COM-interface, the objects ILinCombPara representing parameters of the procedure "Linear
combination of matrices and vectors" and IEditAttributePara representing the parameters of the
procedure "Edit attribute" were removed. They are replaced by the new objects IMatrixFormulaPara
and IAttributeFormulaPara, respectively. (10243)

Territories and POI with surfaces can now be aggregated. Generally, this functionality can be used for
all marked or active objects with surfaces. (11584)

The list 'Transfer and walktimes within stop' has an additional attribute 'Direct Distance' (10206)

The PuT path legs list contains a new relation to vehicle journey items. This allows access to all
elements between the Start time profile item and End time profile item. (11694)

There are new relations for vehicle journey items which enable access to attributes of the previous and
next vehicle journey item. (11473)

When copying line routes with coupling sections, warnings will be generated. (11389)

Demand Procedures:

Tour-based model: It is now possible to define function type and parameters of the distribution utility for
each combination of person group and activity (and mode) independently. (12098)

Tour-based model: It is now possible to define function type and parameters of the mode choice utility
for each combination of person group and mode (and activity) independently. (12097)

Trip distribution: The trip distribution of the 4step-model is now multi-threaded. (11978)

Dialogs:

By default the Tab Multiple in the Edit line route dialog shows all time profiles. This is also the case
when adding new time profiles in the dialog. (11023)

Optionally, meaningful default class limits for the classified display are provided if the attributes have a
restriced value range (type: enum, bool, string). (9214)

The setting of default values for user-defined attributes of type bool has been improved. (12101)

The Tabs PrT-TSys and PuT-TSys of the link dialog have been improved. (11731)

User-defined-attributes: When adding new user-defined attributes, Visum automatically fills the Code
and Name from the field AttID, if the target fields are empty. (10434)

Filters:

Empty values: With the filter operation "Is Empty" it is possible to filter empty values in user-defined
attributes. (11480)



Filter dialogue: One or several filter conditions can be duplicated (9643)

Foreign formats:

OpenStreetMap: The memory consumption during import of OpenStreetMap files was reduced,
allowing larger input files to be processed (12253)

Import of VDV-data: A new add-on module allows the import of public transport network and
timetable-data provided in VDV452-format. With the exception of line blocks, all relevant data including
line route polygons are converted to the respective Visum-objects. Existing additional data columns are
imported to user-defined attributes. The functionality is also accessible through the COM interface.
(11393)

OpenStreetMap: The importer for OpenStreetMap-data has been extended. It is now possible to import
data related to Public Transport (stops, railway tracks and line routes), Barriers and arbitrary other
(points, areas) as POIs. Due to the changes, minor modifications may be required for existing user
defined import configurations. (11439)

Graphical Procedures:

The supply filter for stops in the flow bundle has been improved. For both columns it has been clarified
to which passenger types the supply applies. The improvement also offers new options for filter
definitions. (11568)

When calculating PrT isochrones it is now possible to limit the search to a maximum value which
applies to the selected route choice criterion. If this value is reached and the unlimited search
deactivated, the shortest path search is aborted, i.e. paths beyond the maximum value are not
considered. (12131)

Graphics:

Background maps: Now internet maps (Bing, WMS, OpenStreetMap) can not only be downloaded as a
static map, but also embedded as a live background map. When the map is activated, it automatically
loads the correponding image section and updates automatically when zooming or panning. (11438)

Scaling of Text object: When inserting a Text object, until now you could define a fix size which remains
the same when zooming in and out. Now there is the option to relate the size to the network
coordinates. The text size are scaling now when zooming, the size stays the same related to the
network. (11579)

The dialog of the legend of the network editor has been modernised, e.g. now the manifold options are
clearly arranged in different tabs of the dialog. (11220)

There is a new option for the display of bar labels to avoid overlapping when drawing. Additionally, the
visibility of the bar labels can be adjusted using corresponding options. (2502)

Transfer display of regular services: Bars can be displayed depending on the marking of service
groups. Three different drawing modes are available. (11537)

Transfer display of regular services: The display of the transfer and walk times (out ring) can now be
switched off in the graphic parameters of the transfer display of regular services. (11535)

Junction editor:

When a version file is saved with an open junction editor view, the node in the junction editor is restored
when the version file is opened. (11302)

Main Window:

A new view showing messages of different priorities has been introduced. Like other views the
message window offers the standard functionlity of synchronisation, which allows easily errors and
warnings to be analysed. (7177)

All active procedures in the procedure sequence can now be started using a start-icon in the main
toolbar without having to open the procedure sequence . (9543)

For reasons of standardization some entries in the menus for lists, the time space diagrams, matrix
editor and matrix histograms have been renamed. (12209)

List menu: The list menu has been reorganized. One aspect was to reduce the length of the menu to
ensure the usability also on small screens. Second aspect was to adapt the menu to the corresponding
menu in PTV Vissim 6. (11853)



Search Function: The functionality has been improved significantly. It is now possible to search in any
and also in several attributes simultaneously. The search window, which can be docked in the main
window, includes a list of search results (7513)

The menu Extras has been removed. The dialog Program status was renamed to Network statistics
and can be found under menu Network. The log files can be accessed under menu File -> Show log
files. The license dialog can be found in the menu Help. (12293)

The toolbar 'Spatial Selection' is now docked to the network editor instead of the main window, as most
operations relate to the network editor. (12225)

Window docking: All tool windows (e.g. 'Network', 'Quick view') can now be docked also at the bottom
and top of the main window. This is in particular attractive for the new view 'messages.' (12488)

Matrix editor:

It is now possible to export matrices to a data base from the list view in the matrix editor. (10821)

Miscellaneous:

A default can now be defined for the direction of traffic for new networks. (12281)

Changes to naming, installation folders and documentation: The installation folders and shortcuts have
been unified among the different applications belonging to the PTV Vision Suite. All shortcuts are now
by default placed in a group/start menu folder named PTV Vision 2013 and are stripped to integer
version numbers (PTV Visum 13). Also the installation folders and the locations for user-specific files
have been adapted and unified in this manner. Thereby, log files, projection files, configurations for the
OpenStreetMap-Importer etc. are now located at %AppData%\PTV Vision\PTV Visum 13\ .
All demo networks, examples and tutorials are now installed separately in a folder PTV Vision\PTV
Visum 13 which is located below Users\Public\Documents, which contains data shared among all users
of the system. This allow the examples and tutorials to be modified in place without the need to copy
them to an editable location first.
The COM documentation has been reorganized. The COM interface reference is now included with the
Online Help in the common help format and now also includes information about attributes and
relations of the network objects. The other parts of the former COM documentation are available in the
document C:\Users\Public\Documents\PTV Vision\PTV Visum 13\COM\Introduction to the PTV Visum
COM-API.pdf (11347)

Python-Support: Visum now likewise uses Python 2.7 on all platforms (instead of Python 2.5 on 32-Bit
and Python 2.6 on 64-Bit as before) for the execution of Add-Ins and other Python scripts. The Python
libraries (numpy, wx,...) were updated to up-to-date versions for Python 2.7. (11380)

The COM-reference has been incorporated into the online help and now also covers attributes and
relationships of the network objects. (11787)

The menu ? was renamed to "Hilfe" in the German version. (12204)

The menu entry Options has been renamed to User preferences and can be found in the Edit menu.
The entry Network parameters has been renamed to Network settings. (12294)

Windows 8: PTV Visum 13 was prepared for operation with Windows 8. Due to the missing start menu
in Windows 8, all of the start menu shortcuts to examples and documents which used to be created in
the installation process were replaced by internal shortcuts accessible through the Help-menu. The only
remaining shortcuts are those to the Visum executable and to the Scenario calculation server. These
are grouped togehther with shortcuts to other PTV Vision applications in the group 'PTV Vision 2013'.
Furthermore, the CodeMeter runtime shipped with Visum was upgraded to version 4.5 which is the first
release providing support for Windows 8. All these changes not only apply to Windows 8 installations,
but are effective on older platforms as well. (11545)

Network comparisons:

Display percental deviations: Percental deviations with a value of 0 as denominator are considered as
infinite valaues and are displayed with maximum bar width. In lists etc. they are represented as MIN or
MAX. (9325)

Network editor:



Interaction modes: When changing between different interaction modes in the network editor (adding,
spatial selection, zooming, Flow Bundle, Shortest Path Search,...), users could end up in confusing and
inconsistent states. The management of these interaction modes was refurbished and now falls back to
the previous mode when an activity is stopped. The title bar of the network editor window informs about
the current mode (e.g. Edit:Nodes). Furthermore, the dialogs of the graphical tools (Flow bundle,
Shortest Path Search, Isochrones, Turn Volumes, Desire Lines, Path Projections) where replaced by a
single dockable tool window and their layout was optimized for vertical display besides the network
editor window. (4819)

Valid days which include the same days can now be combined to one valid day. (12279)

Edit shape of line routes: There is a new function 'Fix all profile points', which makes it easier to avoid
unintentional deleting of profile points from line routes. (10890)

Edit Shape: Editing shapes of area objects works now smoother also in case of very high number of
area objects in the network. (11096)

Fuzzy surface alignment: There is now a function to align surface borders, which do not match
perfectly. This function is available special function of area objects, during the shapefile import, via
COM and in the network settings. (11585)

Redirect links: It is now possible to change from- and to-node of an existing link. (11566)

The context menu of lines contains a new entry that enables the disaggregation of lines. (11570)

The context menu of lines has a new entry which allows coupling sections to be deleted. (11581)

The dialog for lines and line routes, respectively, has been extended by the column 'In selection'.
(11580)

The function 'Normalize Surfaces' is now available for selected polygons, either via special function at
all network objects and in the 'Network settings' under 'Surfaces'. (11586)

The options for line aggregation have been extended. (11569)

Other Procedures:

Blocking back calculation: The formula for the calculation of the average waiting time has been
changed. The average waiting time is the total waiting time divided by the effective capacity of the link.
(12128)

Calculate service trip patterns: An extension of this function enables the entry of a lower boundary as
base frequency. (12347)

Run script: Optionally, it is possible to save Python script code in the procedures and execute this as
script. (3701)

Signal offset analysis: When executing the procedure the dialog is now reporting the progress. (11208)

The procedure 'Edit Attribute' can now also edit attributes of the network. (11630)

PrT Assignment:

Assignment with ICA: The assignment method has been revised and improved. Especially, the effects
of blocking back are better replicated. (10239)

ICA calculation: The attribute "ICA upstream adjustment" is now an attribute of the turn. The value
range of the turn attribute is restricted to [0.09; 1.0]. (12423)

ICA, average back of queue: The turn attribute 'ICA average back of queue' is calculated now also for
nodes with the control type All-way Stop, two-way yield, two-way stop and roundabout (HCM).
Additionally, if the turn volume at a two-way yield node has the volume 0, the queue length is set to 0.
(12537)

ICA, signalized: The base saturation flow can now be edited globally for ICU 1 & ICU 2 methodologies
in the general procedure settings. (12424)

ICA, signalized: The factor f_bb (attribute of the leg) was replaced by an attributes for the definition of
the local bus stopping rate. (12336)

ICA, signalized: The factor f_p (attribute of the leg) was replaced by attributes for the definition of the
number of parking movements on the left and right side of the street. (12337)

ICA, two-way control: The ICA calculation for two-way controlled nodes takes the leg attribute value for
channelized control according to the HCM into account. (12313)

PuT assignment:



The connection file now contains an identification-string. (12218)

Headway-based assignment: Time profiles without service trips are ignored in the route search and
choice if the automatic headway calculation is used. (11902)

The calculation of fares has been internally improved. This has positive effects on run times of all
procedures using the fare calculation such as assignment or line cost calcuation. (11992)

The scaling of the timetable-based assignment has been improved. The improvement becomes
effective when many cores are used. (11567)

PuT Line blocking:

Timetable optimization: By the entry of negative layover times Visum can indicate possible
optimizations of the timetable. (11780)

Interpretation of pre and post preparation times: Pre and post preparation times (layover times) are in
practice not always considered as fix. An extension enables an interpretation as "soft" in order to find a
balance between shortfall of minimum layover times and number of required vehicles. (11351)

The procedure line blocking with vehicle interchange runs faster now. (12146)

PuT Operating Indicators:

Optionally, the number of service trips can be calculated for turns and main turns, respectively. (2696)

The procedure PuT Operating Indicators is now multi-threaded. (11571)

PuT Passenger Survey:

Plausibilization of survey data: The options for the search of the preceding and succeeding lines,
respectively, have been extended. (10386)

Scenario Management:

Distribution of calculation to several computers. This module enables the calculation of scenarios to
several computers (computation nodes) which are in one network. All available computers are identified
automatically and listed. The scenarios to be calculated can now be assigned to the computation nodes
individulaay. The data are transfered to the computation nodes and calculation started. Optionally the
calculated results can be transferred back to the origin maschine. (11435)

Network comparisons: The second operation mode of comparing versions, in which the comparison
versions stays opened in the background (new in Visum 12.5) is now also available in the version
comparison in the scenario mangagement. (11188)

The file extension .vpdb is now automatically linked to Visum, i.e. double click on a .vpdb file opens
Visum. (11512)

When comparing scenarios the name 'This network' is now replaced by the code of the leading
scenario. (10317)

Schematic line diagram:

Bundling edges: In addition to the option to couple edges manually there are several new options. They
are:
- Edges are bundled for equal selected attributes
- Edges are bundled for same regular service pattern
The option "Bundle coupled edges" can now be limited to selected edges. (11634)

Differentiation of labelling of 2-hourly displays. The schematic line diagram has the capability of hourly
or 2-hourly displays. For the differentiation of desired displays (such as arrival and departure times) it
needs a more sophisticated labelling system. This is done by an extension of the graphic parameter
settings. (11562)

Display of edges according to defined time frames. The options for the display of edges is extended by
the option to define time frames. The vehicles journeys are not filtered, but the edges are not displayed
when a vehicle journey is outside the defined time frame. This is useful in particular for long-distance
journeys where edges are cut which are outside the time frame. (11564)

Edges inside transfer nodes. Edges can now be edited within a transfer node. The edge can have any
shape as long as it is inside the transfer node. (11559)

When closing a schematic line diagram Visum now saves the layout and prahic parameters internally
and offers to apply them, when opening new schematic line diagram view is opened. (11558)

Subnetwork Generator:



The settings of the sub network generator can now be saved to an .xml file. (9298)

Timetable editor:

Display classic stop sequence: Display has been enhanced by the option to define preferred stops.
(12326)

Find line block item: In the 'Block view PuT line blocks' there is now a dedicated dialog to find line block
items. (12412)

VISUM files:

The names of the output files have been changed from log.txt into protocol.txt and message.txt into
messages.txt. (12315)

In the ANM Export the attribute 'ReducedSpeed' in the ANM file can be mapped to an attribute of lane
turns. The value of the attribute is the speed, that is used for the generation of reduced speed areas.
Negative values prevent the automatic generation of reduced speed areas. (11233)

Optionally, numbers with decimal places can now be saved with up to 12 decimal places in files of type
.net, .dmd, and .tra. (10742)

The calcualtion of a sub network and the ANM Export can be done in one step. Optionally, a PrT
assignment can be executed in the sub network and the files can be imported into Vissim. (10198)

  Breaking Changes

Add-Ins:

General: The Python library numpy which is deployed with Visum was updated and exchanged with a
version optimized for the Intel Math Kernel Library MKL. This should result in faster operation of
Add-Ins making use of numpy (e.g. CalculateMatrix), but can eventually also lead to deviating results.
(11379)

Message handling: The Add-Ins included in the standard installation have been adpated to the new
COM-methods (11175). Thus procedure runs will be stopped, if an error occurs during the Add-in
execution. (12427)

COM:

The COM-method Visum.Net.GraphicParameters.UpdateGU has lost its function and was removed.
(11798)

Data model:

Attribute "Vistro Share HGV": The attribute 'Vistro Share HGV' for Turns and Main Turns was renamed
to "Share HGV". The turn attribute is no used in ICA calculations instead of the also existing link
attribute "Share HGV". This may change results of ICA calculations. (12307)

Formulas:
The possibilities to define formulas have been extended. In the COM-interface, the objects
ILinCombPara representing parameters of the procedure "Linear combination of matrices and vectors"
and IEditAttributePara representing the parameters of the procedure "Edit attribute" were removed.
They are replaced by the new objects IMatrixFormulaPara and IAttributeFormulaPara, respectively.
(10243)

Demand procedures:

Gravity models: The computation of doubly constrained gravity models (e.g. used in trip distribution or
interactively in 'Projection/Projection by Territory' in the matrix editor) internally used wrong matrix
sums. This was fixed. Due to the change, diverging results may occur in certain demand models.
(12178)

Main Window:

The menu Extras has been removed. The dialog Program status was renamed to Network statistics
and can be found under menu Network. The log files can be accessed under menu File -> Show log
files. The license dialog can be found in the menu Help. (12293)

Miscellaneous:



Changes to naming and installation folders: The installation folders and shortcuts have been unified
among the different applications belonging to the PTV Vision Suite. All shortcuts are now by default
placed in a group/start menu folder named PTV Vision 2013 and are stripped to integer version
numbers (PTV Visum 13). Also the installation folders and the locations for user-specific files have
been adapted and unified in this manner. Thereby, log files, projection files, configurations for the
OpenStreetMap-Importer etc. are now located at %AppData%\PTV Vision\PTV Visum 13\ .
Scripts, making assumptions about these folders need to be adapted. (11347)

Python-Support: Visum now likewise uses Python 2.7 on all platforms (instead of Python 2.5 on 32-Bit
and Python 2.6 on 64-Bit as before) for the execution of Add-Ins and other Python scripts. The Python
libraries (numpy, wx,...) were updated to up-to-date versions for Python 2.7. This may eventually
require to adapt custom Python scripts. Furthermore, procedures making use of Add-In operations may
eventually lead to derivating results. (11380)

Spatial reference system transformations: There network is no longer offset from the correct position
when changing the spatial reference system (SRS) to a SRS with a different geodetic datum without
ToWGS parameters available. The internal changes also affect length calculations and intersections
with buffers, whereby procedures using these methods or attributes may compute diverging results.
(12440)

The menu entry Options has been renamed to User preferences and can be found in the Edit menu.
The entry Network parameters has been renamed to Network settings. (12294)

Network comparisons:

Display percental deviations: Percental deviations with a value of 0 as denominator are considered as
infinite valaues and are displayed with maximum bar width. In lists etc. they are represented as MIN or
MAX. In cases were such values are used in further calculations, results may deviate from previous
versions. (9325)

Other procedures, HBEFA:

The intersect operation (used interactively in 'Multi-edit' in 'Intersect'-procedure and in the calculation of
cold emissions in HBEFA) now respects the projection defined for the network when evaluating buffers.
This may lead to diverging results in both procedures. (11246)

Other procedures:

Division by 0 in 'Edit attribute': The procedure 'Edit attribute' used to return a 0 when executing a
division by 0 in one of the terms, even if the target attribute supports empty values. The interactive
operation and formula attributes correctly return empty values. The 'Edit attribute'-procedure now also
returns an empty value (except if one of the other terms results in a non-empty value, of course)
(12053)

Blocking back calculation: The formula for the calculation of the average waiting time has been
changed. The average waiting time is the total waiting time divided by the effective capacity of the link.
(12128)

PrT Assignment:

Assignment with ICA: The assignment method has been revised and improved. Thus, the results of the
assignment change. (10239)

Cycle time optimization: Due to some internal changes, the results of signal time optimization may
change in some specific cases (Signal controlers with only non-conflicting signal groups), if multiple
equally good solutions exist. (11791)

ICA calculation: The attribute "ICA upstream adjustment" is now an attribute of the turn. Thus, the
calculation results obtained change accordingly. (12423)

ICA, signalized: The factor f_bb (attribute of the leg) was replaced by an attributes for the definition of
the local bus stopping rate. When reading data from earlier version the old factor will be converted into
the new attribute. This may change ICA results, if the old factor was at the edges of the range of valid
values. (12336)

ICA, signalized: The factor f_p (attribute of the leg) was replaced by attributes for the definition of the
number of parking movements on the left and right side of the street. When reading data from earlier
version the old factor will be converted into the new attributes. This may change ICA results, if the old
factor was at the edges of the range of valid values. (12337)

PuT assignment:



The connection file now contains an identification-string. This avoids crashes when reading other binary
files. (12218)

Headway-based assignment: Time profiles without service trips are ignored in the route search and
choice if the automatic headway calculation is used. Thus, calculation results can change. (11902)

The timetable-based PuT assignment did not consider vehicle journey which start before the
assignment time interval and end afer its end plus extension. Especially when using short assignment
time intervals and extensions, this resulted in not all possible connections beeing found. This bug was
fixed, which may lead to diverging assignment results. (11738)

PuT Line blocking:

Through some internal improvements, the results of line blocking and block check are allways
consistent. Thes may lead to diverging results of the line blocking procedure. (12277)

Some minor errors in the assessment of waiting times occuring in rare scenarios have been fixed.
These may lead to diverging results in some situations. (11677)

PuT Operating Indicators:

Calculation of vehicle costs: The vehicle costs for territories were calculated wrongly in some
constellations:
- when the network contains a valid line blocking version, but a different vehicle combination was
assigned to a vehicle journey section after the line blocking was calculated
The error was fixed, therefore the results for the "Territory all" change and are now consistent with the
results for the line hierarchie. (12078)

In networks containing links of length 0, the procedure PuT Operating Indicators may have produced
results were the sum of 'ServiceKM of lines' was different then the sum of 'ServiceKm of territory
"TERRITORYALL". This was fixed, which may of course lead to diverging results of the procedure PuT
operating indicators in these cases. (12095)

VISUM files:

The names of the output files have been changed from log.txt into protocol.txt and message.txt into
messages.txt. (12315)
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